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[bookmark: _Toc394914916][bookmark: _Toc485826219]What is the Online Service Desk?
The Online Service Desk is a one stop shop to request anything from Diocesan Communications, HR and ICT teams and will soon be expanded to include Records, the Parish Assistance Unit and the Bishops Office. 
[bookmark: _Toc485826220]Logging in to the Online Service Desk
In order to log into the Online Service Desk either click on this link https://servicedesk.mn.catholic.org.au 
Or use the link on the intranet.

Users having trouble with the first address can try this alternative:
https://servicedesk.mn.catholic.org.au/logon

Most users will be logged in automatically, however you may be prompted for a username and password. The system will accept any username and password on the DOMN/CatholicCare/CSO domain. For parish users that do not currently have an email address, please call Danny Egan (02 1979 1171) to request a login on your behalf. 

If you have logged in before then the system will automatically log you in and you will be presented with the Home tab dashboard.
[bookmark: _Toc485826221]Navigating the system
When you first login you will see the below screen
[image: ]



[bookmark: _Toc485826222]Title bar and tabs
At the top of your screen you will see the title bar.
On the top left will be the available top headings in bold (these will be explained in a later section).
[image: ]

If you click on either of these they will open a new tab.
[image: ]
Over on the right hand side of the screen you can see who you are logged in as, the role you are logged in to (this will be Self Service User, unless you have an Analyst role – Not covered in this guide), access to Help, and the Logout button.
[image: ]
[bookmark: _Toc485826223]Main window
The main window is where you will conduct all of your transactions, from raising requests, to viewing progress of existing items.
[image: ]


[bookmark: _Toc485826224]Home
The first tab shows the following view:
[image: ]

This Home tab hosts a dashboard with four sections to provide key information:
· Announcements – lists active announcements relating to the Online Service Desk. The More Announcements button at the bottom of this section will open all announcements. 
· My Open Items – lists active “My Items” which can be clicked to open the My Item. For more information see the My Items section later in this guide. 
· Top Services – This is a list of the most popular services selected from the Service Catalogue. The Browse All Services link at the bottom of this section opens the full service catalogue described in the next section
· Report an Issue using Template - This is for reporting ICT service faults. These can still be selected via the Service Catalogue discussed in the next section
[bookmark: _Toc485826225]What is the Service Catalogue?
The service catalogue is a full list of forms that you are able to complete for varying departments.
[bookmark: _Toc485826226]Find what you are looking for
When you first login you may be slightly put off by the amount of things you can request. There are several methods for finding the service you require.
[bookmark: _Toc485826227]Using the Search Bar
For example, if you want an iPhone configured you can simply type iPhone into the Search bar at the top and hit enter.
You will then be displayed all requests that refer to iPhones.
[image: ]
Alternately if you wanted to make a request for Aurora, type Aurora into the search and you will see everything to do with Aurora
[image: ]
[bookmark: _Toc485826228]Using the Categories
The second way to search the Service Catalogue is to use the category tree on the left.
The categories attempt to logically section out the different requests you can raise.

When you first log in the system will display the “All Categories” category, this will show you everything.
The second option is “Most Popular” this will show you the most used requests.

But if you are looking for a specific request for HR, you can click on the HR Services category and see all HR related forms.

[image: ]
This works in a similar way for each department.

[bookmark: _Toc485826229]Completing forms
As every request you make can have varying information requirements, each icon you see within the Service Catalogue will have a different form associated to it.

N.B. this section only covers the basics and does not go into the requirements of each form, if you do not understand the requirements of a form please contact the service team (Communications, HR, or ICT) for further information. 

For example, the information you need to complete for borrowing equipment from ICT (shown below)
[image: ]



Is vastly different to the information required when requesting access for an external contractor
[image: ]
[bookmark: _Toc485826230]Required fields
As each form is different they all have different requirements. The required fields in each form are denoted by a red asterisk, as shown below.
[image: ]
Please note that the top two fields are required and the bottom one is not. As indicated by the *



[bookmark: _Toc485826231]Optional fields
Even if a field is not required it is very useful if you can try to fill the information out. This will help the relevant service area progress the request quicker.
[bookmark: _Toc485826232]Form sections
As you navigate the different forms you may notice that some do have different sections, for example the Authority to Recruit form in the HR Services category.
[image: ]
Each section has its own information to complete.
To navigate through the sections either use the continue button in the bottom right of the screen.
[image: ]


Or you can click on the sections themselves.
If you move away from a section without completing some of the required fields you will see an exclamation mark on the incomplete section.
[image: ]
[bookmark: _Toc485826233]Rich Content Fields
Some fields accept rich formatting and pictures, such as the description field in the image below:
[image: ]
These fields can allow text to be formatted using the controls in the toolbar, or you can paste in formatted text, or even an image, such as a screenshot or snip. For steps on creating a screenshot or snip, please see Appendix 1 – Screenshots


[bookmark: _Toc485826234]Submitting a form
When you have completed a form you will need to submit it for progression by the relevant department.
Once complete click on the “Review and Submit” button on the bottom left of the screen
[image: ]
When you click this the page will refresh and give you a read only view of the form you are about to submit.

[image: ]
If you notice an error you are able to click on the Edit button.
To finalise the form, click on the Submit button.


[bookmark: _Toc485826235]Save for later
If you realise half way through the form that you do not have all the information you need to complete you are able to save the form for later.
At any point during completing the form click on the “Save for Later” button
[image: ]
Then click on cancel to return to the Service Catalogue.

When you do so you see the pending requests section over on the right of the screen.
[image: ]

To cancel Pending request click on the X next to the form and it will be removed from the system.

To continue the form, find the icon for the original request, in this instance borrow equipment, and click on it.
When you do so you will be presented with the below.
[image: ]
Click on the continue button and the form will return you to edit mode where you can complete the form and submit it.
[image: ]

[bookmark: _Toc485826236]Underlying workflows/approvals
Some of the business processes handled by the Online Service Desk include approval workflows, particularly HR processes relating to recruitment. At the end of these online forms you are asked to identify the appropriate managers in your reporting line. An example is given on the following page. 


[image: ]

As demonstrated above, the approval fields will have instructions to assist you to identify the correct person for each field. In situations where a person is listed as an approver multiple times (such as when being completed by a senior manager), the system will only require approval from them once 

In most cases, the approval workflows are linear, requiring that each person approve the request in turn. When a request requires approval from someone an “Approval Vote” is generated and an email is sent to them. They can vote to approve or decline the request by replying to the email per the instructions given in the email, or by viewing the Approval item in the My Items as per the example below:
[image: ]
Clicking on the link in the Summary column opens a page showing all the details of the submitted request and buttons to either Approve or Deny the request. Often the approval vote with have an expiration date within a few business days. At that point, the vote expires and a new vote is regenerated, sending another email to the relevant manager seeking their response. If you are interested in following up a request, particularly one that has a workflow behind it, please see the following sections. 



[bookmark: _Toc485826237]Following up your request
Each form you submit will have a unique reference number. When you click on submit you will be sent an email with the unique reference number. There are several ways that you can follow up your request:
· By telephone – If your request is urgent, or you have concerns about your request, please call the relevant service area to alert them to the urgency of your situation
· By Email – The email that you received to confirm receipt of your request can be replied to in order to add information or attachments to your request – just remember not to change the email subject line otherwise your email will not be processed
· My Items – the next section describes the use of the My Items tab, including various ways for adding notes and attachments to your items. As well as viewing the progress of your request. 

[bookmark: _Toc485826238]My Items
The My Items tab within the Online Service Desk will display any form you have previously submitted as well as any items that are awaiting your approval.
You will not see anything that has been raised by someone else.
[bookmark: _Toc485826239]List view
When you open the My Items tab you will see a list of items have been submitted by you, or that require your approval. 

This is split into columns of data
[image: ]

The columns are all self-explanatory and give you a basic summary of the Item’s status.

[bookmark: _Toc485826240]Filters
The Items listed in My Items have filters saved in the drop down list at the top. The default filter (shown below) is ‘All – Active’. Other filters can be used to show different types of items (Approvals, Service Requests and Incidents) or ‘All items’ vs ‘Active Items’. These filters can come in handy if you are a frequent user of the system and wish to keep the listed items relevant. 
[image: ]


[bookmark: _Toc485826241]Interacting with items via My Items
The layout and options for items will vary depending on whether the item is an Incident or a Service Request/Job. An Incident is a type of item used only for ICT faults. A Service Request (also known as a Request or a Job) is a more advanced item that can have many different information fields, approvals and workflows attached. 
[bookmark: _Toc485826242]Incidents
An Incident is a type of item used only for ICT faults, as opposed to Requests/Jobs which are used to request a service of some type. If you would like to review the information of a submitted item click on the link in the second column.
If the form was a fault (Incident) you will see a form similar to the one below:
[image: ]
· If the incident is in an Active state, the “Request Update” option allows you to request an update from the ICT team
· If the issue is no longer occurring, you can click Close Incident
· If the Incident has been resolved, the resolution comments are available
· If the Analyst has requested additional information, there will be a link at the top to “Add More Detail”. 
· If there are any attachments on the Incident, or you wish to upload one, you can use the Attachments section
· The activity section shows a history of any emails sent to you or from you relating to this Incident. It also shows any notes added by you or notes added by the Analyst that were suitable for publishing



[bookmark: _Toc485826243]Service Requests (AKA Requests or Jobs)
A Service Request is used to request a service of some type whereas an Incident is a type of item used only for technology faults. 

If the item is a Service Request, the My Item view will look similar to the below.
[image: ]
The leftmost frame shows basic information such as date submitted, estimated delivery and average delivery times. The estimated delivery is based on the target delivery timeframe for that request type. Generic request types will have long target delivery times as they cannot be estimated. The average delivery time is based on the time it’s historically taken for other requests of the same type to be resolved within the system. 

Depending on the request type and workflow progress, there may also be buttons here to cancel or edit the request. If you need to edit or cancel a request and do not have these options displayed here, please call the relevant service to discuss the situation. An analyst can cancel the request for you or provide other options for adding new or changed information to the request. Some of these options are explained in the next two sections, depending on whether you need to update an Incident or Service Request/Job



The “Item Details” tab (displayed by default) shows the information that you submitted. The Service Request Progress tab to the right looks similar to the example below:
[image: ]

In this tab, you can:
· [bookmark: _GoBack]Create a note on your request  - Just remember to scroll to the bottom and hit the Save button below the Attachments sections after you’ve saved your note
· View notes added by analysts that are suitable for publishing
· View emails sent to you or from you
· View or add attachments
· View Approval Votes – This is especially useful for HR requests (such as ATR and NCR) that require approval by operational managers. By looking in this area, you can see which vote is “Pending” and follow up with that manger. If you find that manager is on extended leave you can:
· If the request has not been approved by anyone yet (i.e. the first level approver is the manager on extended leave), you can edit the request and choose another appropriate approval path
· If the request has already been approved by at least one level, then it cannot be edited. Simply give HR a call and discuss alternative approval options. 
· Identify if the request has been “HR Accepted” or “HR Resubmit Required”. For some important HR requests, the HR Analyst reviews the submitted information and approvals and confirms they conform to policy by clicking “HR Accept”. Once this happens an additional tick box can be seen in this tab. If there are substantial issues with the submission or approvals, the request will need to be resubmitted. In such an event, an email with instructions for this process will be sent to you. 

[bookmark: _Toc485826244]Approvals
If you are an approver for an item, you will see the following when you click on an approval item:

[image: ]
In addition to showing the submitted information, there are buttons at the top right to Approve or Deny the request. Often the approval vote with have an expiration date within a few business days. At that point, the vote expires and a new vote is generated, sending another email to the relevant approver seeking their response and adding a new item to their My Items.  
[bookmark: _Toc485826245]Previously Approved Requests
This tab shows a sortable list of requests for which you were an approving manager. This is useful for managers to view progress on requests that they have previously approved. 
[image: ]
Clicking on any filter button (highlighted in the image above) in any column heading allows you to sort, filter or group by this column. 


Double-clicking on any list open will open the Service Request details is a similar way to the Service Requests displayed in My Items. 
[image: ]
As with Service Requests in My Items, the Details Tab shows the form that was submitted, while the Service Request Progress tab shows a history of notes and emails that are suitable for publishing. 
[image: ]

The bottom section will show attachments and approvals:
[image: ]

If you still have any questions about the progress of the service request, feel free to call the relevant service team. They’ll be happy to answer your questions. 


[bookmark: _Toc485826246]Appendix 1 – Using Screenshots
When logging a request in the Online Service Desk, it is often useful to provide a screenshot to assist with the fulfilment of your request. To copy the whole (every) screen to the clipboard, press the print screen key on your keyboard. 
[image: Image result for print screen]
To copy only the active window, hold Alt while pushing print screen. 

If you only need a section of your screen, you can use the windows snipping tool by typing “snip’ into the search bar
[image: ] [image: ]


Choose “New” and then click and drag to select the portion of the screen that shows the relevant information to copy it to clipboard and display it in the Snipping Tool:
[image: ]
The snip above shows the internet address in question, the product logo shows which system is doing the blocking and the text shows useful information such as the Category of the website and the client IP address. This snip would make it very easy for the ICT team to allow this page if a valid argument was provided. 

At this stage, the image is already in the clipboard ready to be pasted straight into a document or into an Online Service Desk rich formatting field such as below:
[image: ]



Alternatively, click the save button to save the snip as an image file. Just remember to save the snip with a lowercase file extension, such as Capture.png, not Capture.PNG as the system currently cannot accept attachments with uppercase file extensions. 
[image: ]
The file can then be added as an attachment to an existing request in the My Items section of the Online Service Desk using the browse button:
[image: ]
As a final option, you could reply to the email you received confirming receipt of your request (without modifying the subject line) and attach the saved image to the email with a description of the steps that triggered the error. Your email and the attached screen shot would be attached to your submitted item. 


[bookmark: _Toc485826247]Appendix 2 – FAQs

1. What is the Online Service Desk?
· The Online Service Desk is a one stop shop to request anything from Diocesan Communications, HR and ICT teams. In future this will be expanded to incorporate other services as well. 
2. How do I access the Online Service Desk?
· In order to log into the Online Service Desk either click on this link https://servicedesk.mn.catholic.org.au or use the link on the intranet. The Online Service Desk is available across the internet from any office, parish or home. 
· Remote users having difficulty with the address above can try :
https://servicedesk.mn.catholic.org.au/logon 
· Please note, Internet Explorer is the only browser that the Online Service Desk currently supports. This is expected to be fixed soon. 
3. Who can use the online service desk
· The Online Service Desk is for use by any employee to access services appropriate to their role. Some restrictions may apply, please speak to your manager or the PAU for parishes if you have any questions. 
4. Will I be charged for using the Online Service Desk?
· The Online Service Desk is just a new way to access existing services. No changes to charges have been made. Charges may apply for ICT services per the existing Terms of Service available at www.mn.catholic.org.au/ict
5. Can I still call ICT/Communications/Human Resources for assistance?
· All work will need to be logged through the Online Service Desk. If you have difficulty accessing the Online Service Desk or understanding the online forms, the staff from the relevant service (ICT, Communications, and Human Resources) or the PAU for parishes will be able to assist you to log your service request. 
6. How can I log my computer fault if I can’t access the online service desk?
· If you still have access to email, you can send a description of your fault to support@mn.catholic.org.au – If your email is not working, simply call 02 4979 1129 and the ICT team will log and address the issue for you. 
7. As a customer, what do I get out of using this new service?
· The new system will enable you to check the progress of your request online at your own convenience. 
· The new system will generate alerts for shared service staff if your requested has not been fulfilled within target timeframes
· For some services, the new system will automate processes, such as approval workflows, to provide a faster turn-around of service requests
· In coming months, the new system will generate satisfaction surveys for you to provide feedback
8. I work in a parish and I thought the PAU were going to handle all of this for me?
The Parish Assistance Unit can assist with requests relating to shared services. In some cases they will direct you to log your request online, in other cases they may assist you themselves. 



[bookmark: _Toc485826248]Appendix 3 – Renaming File Extensions
[bookmark: _Toc485826249]Within DOMN-Desktop/Windows 7

Open the Pictures Folder, then click Organise and “Folder and search options”
[image: ]

Then click the View tab and clear the tick from “Hide extensions of known file types” and click OK
[image: ]


You should now be able to see the three letter extension of each file name. In this example, the image files have JPG as the file extension. 
[image: ]
Before attaching them to an item in Online Service Desk, the file extension will need to be changed to jpg. To do this, right click the file and choose Rename. You will need to change the name of the file slightly as well as changing the file extension. In this example I will change the file to Tandem Stroller2.jpg
[image: ]

This file can now be attached to any OSD item. 
[bookmark: _Toc485826250]Windows 10

Open the Pictures Folder, then click the View tab and tick “File name extensions”

[image: ]
You should now be able to see the three letter extension of each file name. In this example, the image file has JPG as the file extension. 
[image: ]
Before attaching them to an item in Online Service Desk, the file extension will need to be changed to jpg. To do this, right click the file and choose Rename. You will need to change the name of the file slightly as well as changing the file extension. In this example I will change the file to Sample2.jpg
[image: ]

This file can now be attached to any OSD item. 
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